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1.1  GETTING  STARTED  

The Coal module was developed using Microsoft® Excel 2000. While the module will 
operate with older versions of Excel, it functions best with Excel 2000 or later. Some of the 
Excel basics are outlined in the sections below. Before you use the Coal module, make sure 
your computer meets the system requirements. In order to install and run the Coal module, 
you must have: 

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation. To check this setting, launch Microsoft Excel before opening the Coal 
module. Go to the Tools menu and select “Options...” Click on the “Calculations” tab and 
make sure that the radio button next to “Automatic” is selected, and then click on “OK” to 
close the window. The security settings (discussed next) can also be adjusted at this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu. 

Microsoft Excel Security 

Excel 2003 and Earlier: Since the SIT employs macros, you must have Excel security set 
to medium (recommended) or low (not recommended). To change this setting, launch 
Microsoft Excel before opening the Coal module. Once in Excel, go to the Tools menu, click 
on the Macro sub-menu, and then select “Security” (see Figure 1). The Security pop-up box 
will appear. Click on the “Security Level” tab and select medium. When set to high, macros 
are automatically disabled; when set to medium, Excel will give you the choice to enable 
macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros. Macros must be enabled in order for the Coal module to work. Once they 
are enabled, the module will open to the control worksheet. A message box will appear 
welcoming the user to the module. Clicking on the “x” in the upper-right-hand corner of the 
message box will close it. 

Excel  2007  and  Later:  If  Excel’s  security  settings  are  set at the  default  level  a  Security  
Warning  appears  above  the  formula  box  in  Excel  when  the  Coal  module  is  initially  opened.  
The  Security  Warning  lets  the  user  know  that  some  active  content  from  the  spreadsheet  has  
been  disabled,  meaning  that Excel  has  prevented  the  macros  in  the  spreadsheet  from  
functioning.   Since  SIT  needs  macros  in  order  to  function  properly,  the  user  must  click  the  
“Options”  button  in  the  security  message  and  then  select,  “Enable  this  content”  in  the  pop-
up box.  Enabling the  macro  content for  the  SIT  in  this  way  only  enables  macros  temporarily  
in  Excel  but does  not change  the  macro  security  settings.   Once  macros  are  enabled,  a  
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message  box  will  appear welcoming  the  user  to  module.   Click  on  the  “x”  in  the  upper right-
hand  corner  to close  the  message  box.  

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros. To change the setting, first exit out 
of the Coal module and re-launch Microsoft Excel before opening the Coal module. Next, 
click on the circular “Office Button” in the top left of the screen. At the bottom of the menu, 
select the “Excel Options” button to the right of the main menu. When the Excel Options box 
appears, select “Trust Center” in left hand menu of the box. Next, click the gray “Trust 
Center Settings” button. When the Trust Center options box appears, click “Macro Settings” 
in the left hand menu and select “Disable all macros with notification.” Once the security 
level has been adjusted, open the Stationary Combustion module and enable macros in the 
manner described in the preceding paragraph. 

Viewing and Printing the SIT 

The Coal module contains some features to allow users to adjust the screen view and the 
appearance of the worksheets when they are printed. Once a module has been opened, you 
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom 
percentage or selecting one from the drop down menu. In addition, data may not all appear 
on a single screen within each worksheet; if not, you may need to scroll up or down to view 
additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the Coal module are printed. To do so, go to the File menu, and then select “Print Preview.” 
Click on “Page Break Preview” and drag the blue lines to the desired positions (see Figure 
2). To print this view, go to the File menu, and click “Print.” To return to the normal view, 
go to the File menu, click “Print Preview,” and then click “Normal View.” 

Figure  1.  Changing Security Settings  Figure 2. Adjusting Print Margins 
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1.2  MODULE  OVERVIEW  

     

 

           
           
           

 

This User’s Guide accompanies and explains the Coal module of the SIT. The SIT was 
developed in conjunction with EPA’s Emissions Inventory Improvement Program (EIIP). 
Prior to the development of the SIT, EPA developed the States Workbook for estimating 
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greenhouse gas emissions. In 1998, EPA revisited the States Workbook and expanded it to 
follow the format of EIIP guidance documents for criteria air pollutants. The result was a 
comprehensive, stepwise approach to estimating greenhouse gas emissions at the state 
level. This detailed methodology was appreciated by states with the capacity to devote 
considerable time and resources to the development of emission inventories. For other 
states, the EIIP guidance was overwhelming and impractical for them to follow from scratch. 
EPA recognized the resource constraints facing the states and developed the SIT. The ten 
modules of the SIT corresponded to the EIIP chapters and attempted to automate the steps 
states would need to take in developing their own emission estimates in a manner that was 
consistent with prevailing national and state guidelines. 

Since  most  state  inventories  developed  today  rely  heavily  on  the  tools,  User’s  Guides  have  
been  developed  for  each  of  the  SIT  modules.   These User’s  Guides  contain the  most  up-to-
date  methodologies  that are,  for  the  most part,  consistent with  the  Inventory  of  U.S.  
Greenhouse  Gas Emissions and  Sinks.   Volume  VIII  of  the  EIIP  guidance  is  a  historical 
document that was  last updated  in  August 2004,  and while  these  documents  can  be  a  
valuable  reference,  they  contain  outdated  emissions  factors  and in  some  cases  outdated  
methodologies.   States  can  refer  to Volume  VIII  of  the  EIIP  guidance  documents  if  they  are  
interested  in  obtaining  additional  information  not found  in  the  SIT  or  the  companion  User’s  
Guide.  

The  Coal  module  calculates  methane  (CH4)  emissions from  coal mining  and  abandoned  coal  
mine  activities.   While  the  module  provides  default  data  for  calculating  mining,  post-mining,  
and  abandoned-mine  emissions, if  you  have  access  to more  comprehensive  data  sources,  
they  should  be  used  in  place  of  the  default data.   If  using  outside  data  sources,  or for a  
more  thorough understanding  of  the  tool,  please  refer to  the  following  discussion  for data  
requirements  and  methodology.  

1.2.1  Data Requirements  

To  calculate  CH4  emissions  from  coal  mining  and  abandoned  coal  mines,  the  data  listed  in   

Table  1  are  required  inputs  (again,  note  that defaults  are  available  for  most of  these  data).  
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Table 1: Required Data Inputs for the Coal Module 
Coal Module Sectors Input Data Required 
CH4 from Coal Mining 

Surface Mining 
Activities 

Basin-specific emission factors (ft3 CH4 / short ton coal) 
Surface coal production, by year and basin (‘000 short 
tons) 

Underground Mining 
Activities 

Measured ventilation emissions, by year (million ft3) 
Degasification system emissions, by year (million ft3) 
CH4 recovered from degasification systems and used for 
energy, by year (million ft3) 

Surface Post-Mining 
Activities 

Basin-specific emission factors (ft3 CH4 / short ton coal) 
Surface coal production, by year and basin (‘000 short 
tons) 

Underground Post-
Mining Activities 

Basin-specific emission factors (ft3 CH4 / short ton coal) 
Underground coal production, by year and basin (‘000 
short tons) 

CH4 from Abandoned Coal 
Mines 

A list of abandoned coal mines with the following 
information for each: 
• Mine name or number 
• County of location 
• Coal rank (bituminous, sub-bituminous, or anthracite) 

or basin 
• Year abandoned 
• CH4 emissions at time of abandonment (million cubic 

feet per day) 
• Current status of mine (venting, sealed, or flooded) 
• Percent sealed (choose among 50%, 80%, and 95% 

sealed) 
• CH4 recovered (cubic meters per year) 

1.2.2  Tool Layout  

Since  there  are  multiple  steps to  complete  within  the  Coal  module,  it is  important to  
understand  the  module’s  overall design.   The  layout  of  the  Coal  module  and  the  purpose  of  
its worksheets are  presented  in  Figure  3.   

Figure 3. Flow of Information in the Coal Module* 

*  These  worksheets  are  the  primary  worksheets  used  in the  Coal  module; subsequent worksheets  are  used  to  
populate  the  default data  and  are  provided  for  informational  purposes  only.  
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1.3  METHODOLOGY  

This section  provides  a  guide  to  using  the  Coal  module  of  the  SIT  to estimate  CH4  emissions 
from  coal  mining  and  abandoned  coal  mines.   Within  the  Coal  module,  there  are  two  main  
categories  of  emissions:   emissions  from mining  and  post  mining  activities,  and  emissions  
from  abandoned  underground  coal  mines.   Since  the  methodology  varies  considerably  by  
source, the  details of each  will  be  discussed  in  its respective  step,  following  this  general 
methodology  discussion.  

The  Coal  module  will  automatically  
calculate  emissions after  you  enter  
the e mission  factors  on  the c ontrol  
worksheet and the  required  data  
on the  individual  sector  
worksheets.   The  tool  provides  default data; however,  other  state-specific data  may  be  used  
if  available  (see  Box  1  for  suggestions  on  where  to  find  data).  

Box 1: State Coal Mining Data Sources 
In-state  sources, such as  state  departments  of  energy, 
natural  resources,  or mines, should be  consulted  first.  
Otherwise, default data  provided  by  the  Coal  module  may  be  
used.   

The  Coal  module f ollows  the  general  methodology  outlined  in  the  EIIP  guidance;  however  
because  of  the  automation  of  the  calculations  within  the  tool,  the  order  of  steps  discussed  in  
this  User’s Guide  do  not  follow  the  order  of  steps  discussed  within  the  EIIP  guidance  
document.   This User’s Guide  provides  an  overview  of  the  estimation  methodology  used  in 
the  Coal  module  by  walking  through  the  following  six  steps: (1) select a  state; (2) enter 
emission  factors; (3) complete  worksheet  for CH4  from  coal mining;  (4)  complete  worksheet  
for  CH4  from  abandoned  underground  coal  mines; (5)  review  summary  information;  and  (6)  
export data.    

Step (1) Select a State 

To begin, select the state you are interested in evaluating. By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool. 

Step (2) Enter Emission Factors 

Step  2  on  the  control  worksheet  involves  either selecting  the  default  data  provided  or  
entering  user-specified  emission  factors that will  be  used  throughout the  tool.   To  proceed  
with  the  default data,  select the  “Check  /  Uncheck  All”  button  or  check  the  default box  
directly  to  the  right of  individual  yellow  input cells.   Note  that  this  number c an be  
overwritten  if  you  discover  that the  data  for  your  state  differ  from  the  default  data  provided  
by  the  tool.   To enter user-specified  inputs, enter data  directly  into  the  yellow  input cells.  If  
the  user-specific inputs do  not  match  the  default data  in  the  control  worksheet (i.e.,  the  
default  value  is  overwritten),  the  text  will  appear red.   See  Figure  4  for  locations  of  the  
“Check  / Un check  All”  buttons,  individual  default check  boxes,  and  yellow  input  cells.    
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Figure 4. Control Worksheet for the Coal Module 
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Surface Mining Activities 

The  emission  factors for  surface  mining  activities entered  on  the  control  worksheet  are  
specific  to  each  coal  basin  and  type  of  mine  (underground  or surface).   The  default  emission  
factors from  U.S.  EPA  (2005,  2019)  are  in  cubic  feet  of  CH4  per  short  ton  of  coal.   As 
discussed  in  further  detail  in  Step  3,  estimating  CH4  emitted  from  surface  mining  involves  
multiplying  the  quantity  of  surface-mined  coal from each  coal basin  in  a  state  by  the  
appropriate  emission  factor  for  that basin  (see  Box  2  for  a  discussion  of coal  basins).   The  
emission  factor  accounts for  CH4  liberated  from  the  coal  itself  and  from  surrounding  strata.    
  

Post-Mining Activities 

The  next  step  on  the  control  worksheet  requires  emission  factors  for post-mining  activities  
from  both  underground  and  surface  mines.   These  emission  factors,  like  those  for  surface  
mining  activities,  are  specific  to each  coal  basin  and  type  of  mine  (underground  or  surface).   
These  emission  factors  are  later used  in  the  Coal  Mining  sector  worksheet  to estimate  CH4  
emissions.  The  default  emission  factors  are  from U.S.  EPA (2005,  2019).   Once  you  have  
entered  emission  factors  for surface  mining  activities  and  for post-mining  activities,  use  the  
gray  arrows  to  navigate  to  the  Coal  Mining  worksheet.  
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Box 2: Coal Basin and Rank 

Coal is a combustible sedimentary rock formed by the geologic metamorphosis of prehistoric plant 
materials.  Differences in the origins of the sedimentary plant material combined with differing 
amounts of temperature and pressure acting on the rocks in different areas mean that the 
characteristics of coal vary from place to place.  A basin is a geologic feature that contains a single 
large coal deposit.  While the coal in a basin can vary from place to place, generally it has a number 
of characteristics in common, including rank. 

The most basic difference among types of coal is that of coal rank.  The four major coal ranks, in 
order of increasing purity, are lignite, sub-bituminous, bituminous, and anthracite.  Anthracite, as the 
purest form of coal, is almost entirely carbon, while lower ranks of coal have more and more 
impurities such as sulfur and ash, with lignite being the least pure.  Increased rank also generally 
goes hand-in-hand with increased heating value, although anthracite has a slightly lower heating 
value than bituminous coal, on average. 

Although the coal within a basin is generally of only one rank, the characteristics of the coal vary 
within a basin, often even from mine to mine.  This module calculates emissions based on emission 
factors that are based on known characteristics of the following basins: Northern Appalachian, Central 
Appalachian Basin, Warrior, Illinois, Piceance, Uinta, San Juan, Green River, Raton Mesa, North Great 
Plains, Forest City, Cherokee, Arkoma, Gulf Coast, Alaska, and Washington.  These basins were the 
smallest scale for which complete information was available for use in the tool, and provide a 
reasonable approximation of the characteristics of the coal within them. 

Abandoned Underground Coal Mines 

There are no required inputs for abandoned coal mines on the control worksheet. Since the 
Abandoned Coal Mines sector involves complicated calculations, the gray navigational arrow 
on the control worksheet takes you directly to the Abandoned Coal Mines worksheet. 

Step (3)  Complete  Worksheet  for CH4  from  Coal  Mining   

The  CH4  from  coal  mining  worksheet is  divided  into  emission  calculations  for  underground  
and  surface  activities  for active  mines  and  post-mining  activities.  

Underground  Mining  Activities  

There  are  two  sources  of  emissions  from  underground  mining: (1)  CH4  emitted  from  
underground ventilation  systems  and  (2) CH4  emitted  from  degasification  systems. 
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Emissions  from  underground  ventilation systems  are c alculated  by  summing  the  CH4  
emissions from  ventilation  systems  at  each underground  mine  in  the  state.   Emissions from  
CH4  degasification  systems are  calculated  by  summing  reported  or estimated  emissions  of  
CH4  from  all mines  with  degasification  systems  in  the  state,  and  then  subtracting  the  CH4  
that  is  recovered  and  used  for  energy  purposes.   Figure  5  shows  where  to enter these  data  
in  the  purple  cells.   The  total  CH4  emitted  from  underground  mines  is  the  sum  of  CH4  
emissions  from  ventilation  and degasification  systems,  in  million  cubic  feet.   That  amount  is  
converted  to  metric  tons  of  CH4  using  a  conversion  factor  of  18.92,  and  subsequently  to  
MTCO2E  by  multiplying by  the  GWP  of  CH4.   The equation used  in  the  module  is  shown in 
Equation  1.   The default  mine  ventilation  and  degasification  system  data  used  in  the  tool  are  
based  on  emission  factors and  data  found  in Mroz  et  al.  (1983),  USBM  (1986),  and  U.S.  EPA  
(2003).    

Equation 1. Emissions from Underground Mining Activity 

Emissions (MTCO2E) =  
{Measured Ventilation  Emissions (million  ft3) + [Degasification System  Emissions 

(million  ft3)  –  CH4  Recovered from Degasification Systems and Used for Energy (million  
ft3)]}  × 18.92  g/ft3  CH  × 106  ft3/million  ft3  × 10-6 4  MT/g  ×  25  (GWP of CH4)  

Figure 5. Example of Coal Mining Data Applied in the Coal Mining Worksheet 

Emission Factors (from 
Control worksheet) 

Required Ventilation 
and Degasification 
System Data 

Required Production 

                 

                          

      
 

 

             

 

    

 
  

 
 

 

 

Surface Mining Activities 

CH4  emissions  from  surface  mines  are  estimated  by  multiplying  the  state’s  surface  coal  
production in each coal  basin  by  an  emission  factor  based  on  the  in-situ  CH4  content  for the  
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surface c oal  found  in  each  coal  basin.  The  result  is  converted  to  metric  tons  of  CH4,  by  
dividing  by  1,000  and  multiplying  by  a  conversion  factor  of  18.92.   That  amount  is  
converted  to  MTCO2E  by  multiplying by  the  GWP  of  CH4.   Figure  5  indicates  the  purple  cells  
where  you enter t he  data  on surface c oal  production  in ‘000  short  tons,  while  Equation  2  
shows  the  equation  the  module  uses  to  calculate  emissions  from  surface  mining  activities.  

Equation 2. Emissions from Surface Mining Activity 

Emissions (MTCO2E) =  
Surface Coal Production (‘000 short tons) × Basin-Specific Emission Factor (ft3/short  

ton) × 18.92  g/ft3  CH4  × 103  ft3/’000 ft3  × 10-6  MT/g  × 25  (GWP of  CH4)  

Post-Mining Activities 

Post-mining  activity  CH4  emissions from  both  surface  and  underground  mines  are calculated  
in  essentially  the  same  manner  as emissions from  surface  mining  activity, as Equation  3  
shows.   The  U.S.  EPA  estimates  that CH4  emitted  during post-mining  activities, such  as  
transportation  and  handling  of  coal,  equals  33  percent of  the  in-situ  CH4  content  for  the coal  
(U.S.  EPA 1993).   U.S.  EPA has  used this  formula  to  develop post-mining  emission  factors,  
which  are  used  in  the  module.   Figure  5  indicates  the  purple  cells  where  you  should  enter  
the  data  on  surface  and  underground  coal  production  in  ‘000  short  tons.    

Equation 3. Emissions from Post-Mining Activity 

Emissions (MTCO2E) =  
Coal Production (‘000 short tons) × Basin- and Mine-Specific Emission Factor (ft3/short  

ton) × 18.92  g/ft3  CH4  × 103  ft3/’000 ft3  × 10-6  MT/g  × 25  (GWP of  CH4)  
 

Once  you  have  entered  the  required  data  on  the  sector  worksheet  for  each  year,  the  module  
calculates and  totals  the emissions  from  surface mining,  underground  mining,  and  post-
mining  activities.   After you  have  completed  the  CH4  from coal mining  sector worksheet,  use  
the  gray  navigational  arrow  to return  to the  control  worksheet  and  proceed  to the  
worksheet  for emissions  from  abandoned  coal  mines.  

Step (4)  Complete  Worksheet  for  CH4  from  Abandoned  Underground Coal  
Mines  

The methodology for determining emissions from abandoned underground coal mines is 
based on an EPA White Paper, Proposed Methodology for Estimating Emission Inventories 
from Abandoned Coal Mines (Franklin et al. 2004). The module uses a database of 
abandoned coal mines by state provided in that white paper. Since the methodology is 
complex, it is explained in detail in the worksheet itself (in the abandoned underground coal 
mines worksheet, click the button “Click here to view more about the methodology”). Note 
that the methodology described in this section is only applicable to underground mines, not 
to surface mines. 

For  all  abandoned  mines,  CH4  emissions decline  as a  function  of time;  this decline  can  be  
calculated  by  a  decline  equation  representing  a  decline  curve.   The  decline  curves  vary  
based  on  the  time  since  abandonment,  the nature of  the c oal  seam,  and  the  status  of  the  
mine  (vented,  sealed,  or flooded),  as  follows:  
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•  A  vented  mine  is  one  that  can  release  CH4  to the  atmosphere  freely.   The  emissions  
of  such  a  mine  will  depend  only  on time  since  abandonment  and  coal  characteristics.   

• A  sealed  mine  has  been  sealed  to prevent  the  escape  of  CH4.   However,  given  the  
nature  of  rock  used  to seal  mines,  such  sealing  is  never 100  percent  effective.   The  
effect  of  a  seal  is  not  to prevent  CH4  emissions, but  to  slow  them—to spread  them  
out  over a   longer p eriod.   

• A  completely  flooded  mine  releases  little  to no CH4  to the  atmosphere.   After  a  mine  
is  abandoned,  if  it is  in  an  area  prone  to  flooding,  it will  gradually  fill  up  with  water.   
Therefore,  most  emissions  will  occur i n the  first  few  years  following  abandonment,  
dropping off  quickly  as  the  mine  floods.  

The  decline  equations  for  each  of these  three  statuses are  shown  in  Equation  4.  

Equation 4: Emissions from Abandoned Mines 

Vented:   q = qi × (1 + aT)b  
Sealed:    q  = qi  × (1-c)*(1  +  aT)b  

Flooded:   q = qi  × e(-DT)  
Where,  

q  =  current  emission  rate,  m3/yr  
qi  = emission  rate  at  abandonment, m3/yr  
a  =  constant  unique t o  each  decline c urve  
b =  constant  unique  to  each  decline c urve  
T  =  time  since  abandonment,  yr  
c  = degree  of  sealing of the  mine  (50%, 80%, or  95%)  
D  =  decline rate,  fraction  per  year  (given  as  -0.672)  

Emissions are  calculated  separately  for  each  status of  mine  in  a  state,  using  the  decline  
equations  and  constants  listed  in  Equation 4.  The  coal  rank,  based  on  the  coal  basin  location  
of  the mine,  is  used  to  determine  which  values  of  “a”  and  “b”  to  use  (values  of  “a” and  “b” 
are  built into  the  module).   The  module  then  adds  emissions from  each  status of  mine  
together,  along  with emissions  from  mines  of  unknown status.  

Using the Default List of Mines 

The module provides a default list of abandoned mines for your state, including information 
on coal basin, year abandoned, emissions, and status. The source for the default list of 
mines is the U.S. GHG Inventory (EPA 2019). To complete this worksheet, follow these 
steps: 

1. Choose whether to use the default mine status; if you have more detailed 
information about the status of a mine than the module provides, you may 
change or overwrite the mine status displayed in the green cells. To select 
the default status for all mines, click the check box at the top of the 
worksheet, as shown in Figure 6. 

2. Choose whether to use the default percent sealed for mines of sealed status. 
Again, if you have more detailed information about the status of a mine than 
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the  module  provides,  you  may  change  or overwrite  the  mine  status  displayed 
in  the  green  cells—choosing  among 50%,  80%,  or  95%  sealed.   Figure  6  
shows  the  location  of  the  cells  and  of  the  default  check  boxes.  

3.  At  some  mines,  CH4  emissions are  collected  through  a  degasification  system,  
and  flared  or burned  to  generate  electricity.   Enter information  on  amount  of  
CH4  recovered  at  each  mine  as  shown  in  Figure  6.   Unfortunately,  default  
information  is  not  available  about the  amount of  gas  recovered  at  each  mine.  

Figure 6. Example of Default Data Applied in the Abandoned Coal Mines Worksheet 
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Including Additional Abandoned Mines 

If  you  have information  on  additional abandoned  mines  in your  state  that aren’t provided  in  
the  default data  from  EPA  2019,  you  may  add  this  information  by  clicking  on  the  “+”  sign  
next to  “Additional  Abandoned  Coal  Mines”  and  entering  the  required data  as  shown  in  
Figure  7.   Once  this sector  worksheet  is  complete,  use  the  gray  navigational  arrow  to  return  
to the  control  worksheet  and  then  proceed  to the  summary  worksheet.   You  may  also  use  
one  of  the  gray  navigational  arrows  at the  top  to  view  a  summary  worksheet  for the  
abandoned  coal  mines  sector  before  proceeding  to the  general  summary  sheet.  
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Figure 7. Example of Additional Data Applied in the Abandoned Coal Mines 
Worksheet 
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Step (5) Review Summary Information 

The  steps  above  provide  estimates  of  total  CH4  emissions from  coal  mining and  abandoned  
coal mines.   The  information  from  both  worksheets  is  presented  on  the  summary  
worksheet,  which  displays  results  in  metric  tons  of  carbon  dioxide  equivalent (MTCO2E) and  
metric  tons  of  CH4  (MTCH4).   Figure  8  shows  the summary  worksheet.   In  addition,  the  
results  are  displayed  in  graphical  format at  the  bottom  of  the  summary  worksheet.   
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Figure 8. Example of the Emissions Summary Worksheet in the Coal Module 

Step (6)  Export  Data  

The final step is to export the summary data. Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
GHG inventory for the state. 

To  access  the  “Export  Data”  button,  return  
to  the  control  sheet and  scroll  down  to  the  
bottom  (step  6).   Click  on  the  “Export  Data” 
button  and  a  message  box  will  open  that 
reminds  the  user  to make  sure  all  steps of  
the  module  have  been  completed.   If  you  
make  any  changes  to  the  Coal  module  later,  
you  will then  need  to re-export the  results.  

Note: the resulting export file  should not be  
modified.   The  export file  contains  a  summary  
worksheet that allows  users to  view  the  results, as  well a s  
a  separate  data  worksheet with an unformatted  version of  
the  results.  The  second  worksheet, the  data  worksheet,  
contains  the  information  that is  exported  to  the  Synthesis  
Tool.  Users  may  not  modify that worksheet.   
Adding/removing  rows,  moving  data, or  making  other  
modifications  jeopardize  the  ability  of  the  Synthesis  
Module  to  accurately  analyze  the  data.  
 Clicking  “OK”  prompts  you  to  save  the  file.   

The  file  is  already  named,  so you  only  need  
to choose  a  convenient  place  to save  the  file.   After  the  file  is  saved,  a  message  box  will  
appear  indicating  that the  data  was  successfully  exported.    

While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 
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Following data export, the module may be reset and run for an additional state. 
Alternatively, you may run the remaining modules of the SIT to obtain a comprehensive 
profile of emissions for your state. 

1.4  UNCERTAINTY  

In the upper right-hand corner of the summary worksheet is a button: “Review discussion of 
uncertainty associated with these results.” By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 

 
1.5  REFERENCES  

Franklin,  P.,  E.  Scheehle,  R.C.  Collings,  M.M.  Coté,  and  R.C.  Pilcher.  2004.   White  Paper:  
Proposed  Methodology  for  Estimating  Emission  Inventories  from  Abandoned  Coal  Mines.  
U.S.  EPA,  Prepared for  2006 IPCC  Greenhouse  Gas  Inventories  Guidelines  Fourth  
Authors  Experts  Meeting.  Energy:  Methane Emissions  for C oal  Mining  and  Handling,  
Arusha,  Tanzania.  

Mroz,  T.H.,  Ryan,  J.G.,  and  Bryer,  C.W.  1983.   Methane  Recovery  from  Coalbeds:  A  
Potential  Energy  Source.  Report  prepared  for  U.S.  Department  of  Energy.  DOE/METC/  
83-76.   

USBM. 1986. Circular 9067, Results of the Direct Method Determination of the Gas 
Contents of U.S. Coal Basins. U.S. Bureau of Mines. 

U.S.  EPA.  2019.  Inventory  of  U.S.  Greenhouse  Gas  Emissions  and  Sinks:  1990  –  2017.   
Office  of  Atmospheric  Programs,  U.S.  Environmental  Protection  Agency.  Available  at: 
https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks-
1990-2017  

U.S.  EPA.   2005.  Surface  Mines Emissions  Assessment, U.S.  EPA  Draft  Report,  November  
2005.   

U.S.  EPA.   2003.  Methane  Emissions  Estimates  &  Methodology  for  Abandoned  Coal  Mines  in  
the  U.S.  Draft Final  Report.  Washington,  DC.  June  2003.  

U.S.  EPA.   1993.  Anthropogenic  Methane  Emissions  in  the  United States: E stimates  for  
1990.   Report  to Congress.  U.S.  Environmental  Protection  Agency,  Office  of  Air and  
Radiation.   EPA 430-R-93-003.   April.   Washington,  DC.  

State Greenhouse Gas Inventory Tool User’s Guide for the Coal Module 1.15 

https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks-1990-2017
https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks-1990-2017

	1.1  Getting Started
	Microsoft Excel Settings
	Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to automatic calculation.  To check this setting, launch Microsoft Excel before opening the Coal module.  Go to the Tools menu and select “Options...” Click on the “Ca...
	Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make sure that the box next to the “Automatic” option is checked from the pop-up m...
	Microsoft Excel Security
	Excel 2003 and Earlier: Since the SIT employs macros, you must have Excel security set to medium (recommended) or low (not recommended).  To change this setting, launch Microsoft Excel before opening the Coal module.  Once in Excel, go to the Tools me...
	When Excel security is set to medium, users are asked upon opening the module whether to enable macros.  Macros must be enabled in order for the Coal module to work.  Once they are enabled, the module will open to the control worksheet.  A message box...
	Excel 2007 and Later: If Excel’s security settings are set at the default level a Security Warning appears above the formula box in Excel when the Coal module is initially opened. The Security Warning lets the user know that some active content from t...
	If the Security Warning does not appear when the module is first opened, it may be necessary to change the security settings for macros.  To change the setting, first exit out of the Coal module and re-launch Microsoft Excel before opening the Coal mo...
	Viewing and Printing the SIT

	1.2 Module Overview
	1.2.1 Data Requirements
	1.2.2 Tool Layout

	1.3 Methodology
	Step (1) Select a State
	Step (2) Enter Emission Factors
	Surface Mining Activities
	Post-Mining Activities
	Abandoned Underground Coal Mines

	Step (3) Complete Worksheet for CH4 from Coal Mining
	The CH4 from coal mining worksheet is divided into emission calculations for underground and surface activities for active mines and post-mining activities.
	Underground Mining Activities
	Surface Mining Activities
	Post-Mining Activities

	Step (4) Complete Worksheet for CH4 from Abandoned Underground Coal Mines
	Using the Default List of Mines
	Including Additional Abandoned Mines

	Step (5) Review Summary Information
	Step (6) Export Data

	1.4 Uncertainty
	1.5 References



